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System Requirements

- Microsoft Windows® XP 32-bit (Service Pack 2)
- Microsoft Windows® Vista® 32/64-bit
- USB 2.0 Compliant hardware and system
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Important Information

Before you get started, please NOTE:
Do not place Wireless USB adapter under direct sunlight or near high heat emitting devices;
Do not place Wireless USB adapter near water or wet surfaces to avoid electric hazards;
Do not place Wireless USB adapter on any moving or unstable surfaces.
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Package Contents

1 x Wireless USB Host Adapter (for PC)

1 x USB 2.0 Extension Cable (5 ft.)

1 x Quick Start Guide

1 x Registration / Warranty Card

1 x Installation CD (with User Manual)
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LINK PWR

Device Overview

1. LINK:  Data Transfer Activity Indicator
LED blinks when data is being transferreda. 

2. PWR: Power 
LED is solid when powered by the PCa. 

1 2

Wireless USB Host Adapter



8 9

Installation

Please always check www.iogear.com for the latest drivers.

IMPORTANT NOTE:
If you purchase the hub kit GUWH104KIT, please refer to Appendix “Compatibility with GUWH104KIT” of 
this User’s Manual in the CD-ROM for important information regarding steps to perform before the instal-
lation of the Wireless USB Host Adapter.

Before installing the Wireless USB Host Adapter GUWA200 software, please make sure that the Wireless 
USB Host Adapter and other Wireless USB device are not connected to the computer and the Wireless 
USB device is not powered.
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Software Installation

Notes:
If installing on Windows XP, Service Pack 2 (SP2) is required. Please Verify that SP2 has been 1. 
installed on your PC before proceeding with the UWB installation software.

Microsoft .NET Framework 2.0 is required by the driver software. Once you begin the 2. 
software installation, if .NET Framework 2.0 is not installed on your PC, the software will 
automatically prompt you to install it before proceeding to the UWB software installation.

Step 1 – Insert installation CD into the CD drive 
on your computer.

Step 2 – Select “Software Installation” from 
the menu.
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Step 3 – The next screen will let you choose 
whether to install the latest software from the 
IOGEAR website or to install the software directly 
from the installation CD.

By choosing Option 2: Download latest 
software installer from the Web, a web browser 
window will launch directing you to the IOGEAR 
website where you’ll find the most up-to-date 
software. Once you download the software, 
double-click on the .exe file to begin the installation 
process.

If selecting Option 1: Install directly from CD, the 
installation will start automatically.
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Step 4 – If you previously installed the GUWH104KIT software, then you will be prompted to remove the 
software from your computer. For more information, please see Appendix.

Step 5 – For Windows XP users, if you do not have Microsoft .NET Framework 2.0 installed, you will be 
prompted to have it installed.

1. Click “Yes” to install .NET 2.0 Framework
2. Check “License Agreement” and click “Install”
3. Click “Finish” to complete installing .NET Framework 2.0
4. Restart the computer when prompted
5. Eject your CD and go to Step 1.

Important: After the wizard has finished installing the software, reboot your computer if 
prompted to do so.
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Connecting Wireless USB Host Adapter

Once you connect the Wireless USB Host Adapter to your computer, its drivers will be installed automatically.

There are 2 options to connect the Wireless USB Host Adapter to your computer.

Option 1
Verify that the antenna on the Wireless USB Host Adapter is securely attached and pointed in a vertical 
position. Plug the Wireless USB Host Adapter into an available USB 2.0 port on your computer.
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LINK PWR

Option 2
If using a Desktop PC, plug the Wireless USB Host 
Adapter into an available USB 2.0 port utilizing the 
provided extension cable. Place the extension cable 
on a flat surface, preferably the top of the desk/
work area in order to ensure a good line-of-sight 
signal with your “Certified Wireless USB device”.

Once the Wireless USB Host Adapter has been 
installed properly you will have the ability to  
connect to your “Certified Wireless USB device”. 
You will need to follow the instructions set forth by 
the manufacturer of your Wireless USB device for 
its own software installation and associating to the 
PC to gain full functionality of the Wireless USB 
Host Adapter.

Upon finishing this process you will be ready to use 
your Wireless USB Host adapter and enjoy your 
new Wireless USB device.

Congratulations, your Wireless USB Host 
Adapter is ready for use.
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Wireless USB Manager

The Wireless USB Manager is a simple and easy-
to-use interface that allows you to manage your 
Wireless USB devices and control your Wireless 
USB Host Adapter settings. The Wireless USB 
Manager can be accessed via the Wireless USB 
Manager icon located in the Windows system tray.

To launch the Wireless USB Manager, double 
click on the Wireless USB Manager icon. On the 
main pane, you will find an icon representing your 
“Certified Wireless USB Device”. If your Wireless 
USB device is not connected, the icon will be 
grayed out.

Illustrator below is for your reference.
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If your Wireless USB device is connected and 
working, then the icon will change and show the 
current signal strength.

Illustrator below is for your reference.

The View menu will give the option of what type of 
devices you wish to display (All Devices,  
Connected Devices and Disconnected Devices).

The Options menu will give the option to launch 
Host Settings window and turn the Wireless USB 
Host Adapter radio on or off.

The Help menu offers quick help on how to  
connect devices to your Wireless USB Host 
Adapter.
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Wireless USB Host Adapter Settings

To manage the Wireless USB Host Adapter  
settings, either select “Host Settings” in the “ 
Option” menu of the Wireless USB Manager  
application or right click on the Wireless USB 
Manager icon in the Windows tray.

• General Settings

Enable the Wireless USB radio: turn on or off the 1. 
Wireless USB radio.

Host name: Change the name of your Wireless 2. 
USB Host Adapter.

Cable association connection rules: Always, 3. 
Never or Ask me each time. By default Wireless 
USB will ask you each time to do the cable 
association.
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• Advanced Settings

Channel selection: this function allows you to 
manually set a radio channel (not recommended) 
for the wireless communication (combination of 
Band Group and Channel).

For optimal performance, the automatic setting is 
recommended.
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Frequently Asked Questions

For the latest FAQs, please go to IOGEAR website (www.iogear.com).

1. Why can’t I install .NET?

You may have an older version of .net, preventing the newer one from being installed. Using Add/Remove 
Programs or Programs and Features on the Control Panel, uninstall any version of Microsoft .NET  
Framework older than version 2.0. Then install Microsoft .NET Framework from the Wireless USB Host 
Adapter installer.

2. My Wireless USB Host Adapter is plugged into my computer and my Wireless USB device is powered 
but I do not see anything on my display. What’s wrong?

Check the Wireless USB Manager to see if there is an icon for your Wireless USB device. If there is no 
icon, try unplugging and plugging-in your Wireless USB Host Adapter to reload the Wireless USB device 
driver.
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If you see an icon that is grayed out in the Wireless 
USB Manager, try resetting the Wireless USB 
device adapter by unplugging its power cord and 
plugging it back in. You should see the icon in the 
Wireless USB Manager appear in color when it is 
connected.

Illustrator below is for your reference.

Still not connected?

Double check that the radio for your Wireless 
USB Host Adapter is Enabled in the Wireless 
USB Manager.
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Function GUWA200

Operating System Support Microsoft XP 32-bit; Microsoft Vista 32/64-bit

PHY Data Rate 53.3Mbps, 80Mbps, 106.6Mbps, 160Mbps, 200Mbps,   
320Mbps, 400Mbps, 480Mbps

Operating Range Up to 30 feet (10 meters)

Frequency 3.1GHz to 4.8GHz (WiMedia Band Group 1)

Number of Channels 7 channels (3 FFI + 4 TFI)

RF Modulation Type QPSK/DCM

Interface USB

USB Specification Certified Wireless USB 1.0; USB 2.0

Association Mode Cable Association

Antenna Type Omni directional

Power Consumption Wireless USB Host Adapter: 1.2W

Technical Specifications
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IN NO EVENT SHALL THE DIRECT VENDOR’S LIABILITY FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE PRODUCT, DISK, OR ITS 
DOCUMENTATION EXCEED THE PRICE PAID FOR THE PRODUCT.

The direct vendor makes no warranty or representation, expressed, implied, or statutory with respect to 
the contents or use of this documentation, and especially disclaims its quality, performance, merchantability,  
or fitness for any particular purpose.

The direct vendor also reserves the right to revise or update the device or documentation without  
obligation to notify any individual or entity of such revisions, or updates. For further inquiries please  
contact IOGEAR.

Limited Warranty
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This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:  
(1) this device may not cause harmful interference, and (2) this device must accept any interference  
received, including interference that may cause undesired operation. This device is authorized under 47 
CFR 15.519 (the FCC Rules and Regulations). The operation of this device is subject to the following 
restriction: This UWB device shall transmit only when it is sending information to an associated receiver. 
This UWB device shall cease transmission within 10 seconds unless it receives an acknowledgement from 
the associated receiver that its transmission is being received. An acknowledgement of reception must 
continue to be received by the transmitting device at least every 10 seconds of operation or the UWB 
device must cease transmitting.

Federal Communications Commission (FCC) Statement
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IOGEAR

23 Hubble

Irvine, CA 92618

P 949.453.8782

F 949.453.8785

Visit us at: www.iogear.com

 

 

Contact

© 2008 IOGEAR® Part No. M1070 
IOGEAR, the IOGEAR logo, are trademarks or registered trademarks of IOGEAR, Inc. Microsoft and Windows are registered trademarks of 
Microsoft Corporation. All other brand and product names are trademarks or registered trademarks of their respective holders. IOGEAR makes 
no warranty of any kind with regards to the information presented in this document. All information furnished here is for informational purposes 
only and is subject to change without notice. IOGEAR, Inc. assumes no responsibility for any inaccuracies or errors that may appear in this 
document.
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I.  Compatibility with IOGEAR GUWH104KIT

Important: To retain the functionality of both the Wireless USB Host Adapter (GUWA200) and the  
GUWH104KIT, you MUST follow these steps:

Uninstall the GUWH104KIT software by using Add/Remove Programs or Programs and Features on 1. 
the Control Panel. Please select and remove “Ultrasuite with WiCenter Basic”. The Wireless USB Host 
Adapter (GUWA200) installer will not allow you to proceed until this software is removed.
Complete the installation of the Wireless USB Host Adapter as shown in the Software Installation section.2. 
Install the GUWH104 software “Driver Hub Only” for your Wireless USB Hub from IOGEAR website. 3. 
Please make sure that you are in the correct product page http://www.iogear.com/support/dm/driver/
GUWH104#display.
Use the Wireless USB Host Adapter (GUWA200) to communicate with your Wireless USB Hub 4. 
(GUWH104).

Note: After this upgrade, the Wireless USB Host Adapter (GUWA100U) will not function with 
the Wireless USB device or the Wireless USB Hub (GUWH104) on the PC system where the 
GUWA200 software has been installed. However you may use this Wireless USB Host Adapter 
(GUWA100U) on a different PC.

For more support information, please contact IOGEAR.

Appendix
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II. Cable association with Wireless USB devices

Association Concept:
In order to establish a secure wireless connection, between both the Wireless USB Host Adapter and the 
Wireless USB devices, you will need to go through the cable association process. The association process 
will allow the Wireless USB Host Adapter and the Wireless USB device to exchange security information 
about each other necessary to operate in a secured wireless mode.

Association Process:
Please refer to your Wireless USB device documentation for more information on its settings for cable 
association.
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Cable association steps:
Make sure that the Wireless USB Manager is 1. 
running. Check your Windows tray for the  
Wireless USB Manager icon.

Power on your Wireless USB device.2. 
Connect the USB cable between an available 3. 
USB port on your computer and your Wireless 
USB device.

Complete cable association by pressing the 4. 
“Accept Association” button when prompted. 
 
Illustration below is for your reference. 
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Remove the USB cable from your Wireless USB 5. 
device and computer then follow instructions 
specific to your Wireless USB device for  
wireless operation. 
 
Associated Wireless USB devices will appear 
as icons in the Wireless USB Manager. When 
the Wireless USB device is connected to your 
computer, the icon will appear in color. 
 
Illustration on the right is for your reference.
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FUN

IOGEAR offers connectivity solutions that are innovative, fun, and stylish, 
helping people enjoy daily life using our high technology products.

GREEN

IOGEAR is an environmentally conscious company that emphasizes the 
importance of conserving natural resources. The use of our technology solutions 
helps reduce electronic waste.

HEALTH

IOGEAR supports healthy and fit lifestyles.  By integrating products with 
the latest scientific developments, IOGEAR’s solutions enhance the life of 
end-users.
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